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PRAKATA

Puji syukur penulis panjatkan kehadirat Tuhan Yang Maha 
Esa karena atas berkat rahmatnya penulis dapat menyelesaikan 
Buku Ajar yang berjudul “Komparasi Parametrik dan Non-
Parametrik”. 

Buku ajar ini bukan sebagai pengganti  perkuliahan me
tode penelitian, namun diharapkan dapat menambah pema
haman bagi mahasiswa kedokteran di Fakultas Kedokteran, 
Universitas Surabaya terkait dengan statistika. Materi yang 
dibahas pada buku ajar ini adalah uji komparasi untuk skala data 
parametrik dan non-parametrik. Buku ajar ini berisi mengenai 
tujuan instruksional pembelajaran, materi pembelajaran, dan 
soal latihan. Cara penyelesaian dijabarkan secara bertahap 
sehingga menjadi lebih mudah dipahami oleh mahasiswa. 

Penulis menyadari bahwa penyusunan buku ajar ini masih 
jauh dari sempurna. Berbagai masukan mengenai buku ajar 
iniakan penulis terima dengan senang hati sebagai perbaikan di 
masa mendatang. Penulis juga berterima kasih kepada semua 
pihak yang telah membantu terbitnya buku ajar ini.

Surabaya, April 2022
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STATISTIKA KOMPARASI 
DAN HIPOTESIS1

Latar Belakang
Statistika komparasi merupakan suatu uji yang digunakan 

untuk menilai perbedaan antar-kelompok. Jenis pengujian 
ini sering digunakan oleh mahasiswa pada penelitian di 
laboratorium dan masyarakat. Sedangkan hipotesis adalah 
sebuah dugaan atau jawaban sementara dari sebuah penelitian 
yang akan dibuktikan dengan statistika.

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat mengetahui dan memahami tentang gambaran statistika 
komparasi dan hipotesis.

Tujuan Instruksional Khusus
Setelah mempelajari keseluruhan bab dan mengikuti per

kuliahan diharapkan mahasiswa mampu:
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1. 	 Memahami Sejarah statistika
2. 	 Memahami Statistika Kedokteran
3. 	 Memahami Uji Komparasi
4. 	 Memahami Hipotesis Penelitian

1.1 	 Sejarah Statistika
Kata Statistik berasal dari Bahasa latin “Ratio Status”, da

lam bahasa Itali sama dengan “Regio’n di stato”. Istilah tersebut 
biasa digunakan untuk menyatakan hal yang berhubungan 
dengan kenegaraan, kemudian istilah tersebut berkembang 
menjadi “statistia” yang berarti orang yang berkecimpung 
dalam urusan kenegaraan. Pada tahun 1749 untuk pertama 
kalinya Gottfried Achenwall menggunakan statistik dalam 
Bahasa Jerman sebagai nama bagi kegiatan analisis data ke
negaraan.

Pada abad ke-19 dan awal abad ke-20 statistika mulai 
banyak digunakan dalam bidang matematika. Cabang statistika 
yang ada pada saat ini sangat luas digunakan untuk mendukung 
metode ilmiah, statistika inferensi dikembangkan pada paruh 
abad ke-19 dan awal abad ke-20 oleh Ronald Fisher (peletak 
dasar statistika inferensi), Karl Pearson (metode regresi linier) 
dan William Sealey (meneliti problem sampel berukuran 
kecil). Pada saat ini dapat dikatakan statistika telah menyentuh 
semua bidang ilmu pengetahuan mulai dari astronomi hingga 
linguistika, ekonomi, biologi, psikologi serta kesehatan, 
hampir semua bidang banyak dipengaruhi oleh statistika.

Perkembangan statistika kedokteran mengalami hambatan 
pada saat itu karena masih banyak klinisi skeptis yang tidak 
setuju penggunaan metode statistik dalam bidang kedokteran 
dengan alasan statistik hanya merupakan kumpulan angka 
dan tidak sesuai dengan kenyataan dan etika manusia. Alasan 
lain tidak digunakan statistika dalam bidang kedokteran 
adalah karena dokter hanya tertuju kepada penderita individu 
dan setiap penderita akan berbeda dengan penderita lainnya 

Statistika Komparasi 
dan Hipotesis



Komparasi Parametrik 
dan Non-Parametrik 5

statistik non-parametrik atau parametrik ada beberapa syarat 
yang harus dipenuhi dalam menentukan uji komparasi yang 
digunakan.

Tabel 1.1. Syarat Umum Pemilihan Uji Komparasi

Berdasarkan jenis data yang digunakan, biasanya dalam 
penggunaan teknik analisis statistik didasarkan pada tujuan 
penelitian/bentuk hipotesis penelitian.
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Secara prosedural hipotesis penelitian diajukan setelah 
peneliti melakukan kajian pustaka karena hipotesis penelitian 
adalah rangkuman dari kesimpulan-kesimpulan teoretis yang 
diperoleh dari kajian pustaka. Penyusunan landasan teori ju
ga merupakan langkah penting untuk membangun sebuah 
hipotesis. Landasan teori yang dipilih haruslah sesuai dengan 
ruang lingkup permasalahan. Landasan teoretis akan menjadi 
suatu asumsi dasar peneliti dan sangat berguna pada saat me
nentukan suatu hipotesis penelitian. 
Hipotesis penelitian dapat dirumuskan melalui jalur:
1. 	 Membaca dan menelaah ulang (review) teori dan konsep 

yang membahas variabel penelitian dan hubungannya 
dengan proses berpikir deduktif.

2. 	 Membaca dan me-review temuan-temuan penelitian ter
dahulu yang relevan dengan penelitian lewat berpikir 
induktif.
Sebelum melakukan analisis komparasi, maka diperlukan 

membuat sebuah hipotesis. Hipotesis untuk statistik komparasi:

H0: μ1 = μ2
H1: μ1 ≠ μ2

Atau

H0: Tidak ada perbedaan perlakuan pertama dan kedua
H1: Ada perbedaan perlakuan pertama dan kedua

Ada dua jenis kesalahan yang sering terjadi ketika peng
ujian hipotesis. Ketika kita menolak hipotesis nol, padahal 
hipotesis nol itu benar, kesalahan tersebut disebut kesalahan 
jenis I atau type error I. Sedangkan jika kita menerima hipotesis 
nol, padahal hipotesis tersebut salah disebut kesalahan jenis II 
atau type error II. 
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Tabel 1.3. Kesalahan Pengujian Hipotesis
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	 c. 	 Perbandingan
	 d. 	 Hubungan
	 e. 	 Semua salah

7. 	 Perbedaan penggunaan uji komparasi dapat dibagi menjadi 
2 kelompok besar. Hal tersebut akan menentukan jenis 
uji statistik komparasi yang akan digunakan. Kelompok 
yang dimaksud adalah

	 a. 	 Observational dan Eksperimental
	 b. 	 Deskripsi dan Prevalensi
	 c. 	 Validitas dan Reliabilitas
	 d. 	 Parametrik dan Non-Parametrik
	 e. 	 Hipotesis dan Non-Hipotesis

8. 	 Suatu data penelitian memiliki jenis data yang bersifat 
kuantitatif. Oleh karena itu, penggunaan uji yang 
disarankan pada kelompok data tersebut adalah  

	 a. 	 Validitas
	 b. 	 Eksperimental
	 c. 	 Observational
	 d. 	 Parametrik
	 e. 	 Non-Parametrik

9. 	 Suatu data penelitian diketahui memiliki data yang tidak 
berdistribusi normal. Hal yang dianjurkan oleh peneliti 
tersebut adalah 

	 a. 	 Mengganti data
	 b. 	 Menggunakan hipotesis
	 c. 	 Menormalkan distribusi data
	 d. 	 Menggunakan uji normalitas lain
	 e. 	 Menggunakan uji non-parametrik
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berat badan melalui penggunaan herbal. Hipotesis H1 
yang sesuai dengan penelitian di atas adalah 

	 a. 	 Terdapat perbedaan BB sebelum  dan sesudah meng- 
		  gunakan herbal.
	 b. 	 Tidak ada persamaan  yang relevan  BB sebelum dan 
		  sesudah menggunakan herbal.
	 c. 	 Terdapat perbedaan korelasi BB sebelum dan sesudah 
		  menggunakan herbal.
	 d. 	 Tidak ada hubungan antara BB sebelum dan sesudah 
		  menggunakan herbal.
	 e. 	 Terdapat  persamaan  hubungan BB  sebelum dan se- 
		  sudah menggunakan herbal.

Jawaban dan Pembahasan

1. 	 C
	 Pada tahun 1749, statistika sudah mulai digunakan 

oleh Gottfried Achenwall. Namun perkembangan yang 
paling pesat terjadi pada abad ke-19 dan awal abad ke-
20 statistika dalam bidang matematika. (Bab 1.1 Sejarah 
Statistika)

2. 	 E
	 Pada abad ke-19 dan awal abad ke-20, statistik telah 

dikembangkan oleh beberapa ahli seperti Ronald Fisher 
(peletak dasar statistika inferensi), Karl Pearson (metode 
regresi linier) dan William Sealey (meneliti problem 
sampel berukuran kecil). (Bab 1.1 Sejarah Statistika)

3. 	 A
	 Hambatan perkembangan statistika dalam bidang kedok

teran dikarenakan adanya sifat skeptis dan adanya pe
mikiran yang hanya tertuju kepada penderita individu dan 
setiap penderita akan berbeda dengan penderita lainnya. 
(Bab 1.1 Sejarah Statistika)
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4. 	 D
	 Terdapat tiga pengertian atau pemahaman mengenai  

statistika yaitu:
	 l 	Statistika  merupakan kumpulan angka yang dihasil- 
		  kan dari pengukuran  atau perhitungan  yang  disebut 
		  data.
	 l	 Statistika dapat pula diartikan sebagai statistik sampel.
	 l 	Statistika sebagai suatu metode ilmiah yang dapat di- 
		  gunakan sebagai  alat bantu dalam  mengambil kepu- 
		  tusan mengadakan  analisis data  hasil penelitian dan 
		  lain-lain.
	 (Bab 1.2 Statistika Kedokteran)

5. 	 C
	 Metode statistika dalam bidang kedokteran merupakan 

alat bantu yang sangat baik. Namun terdapat alat pen
dukung lainnya seperti pemeriksaan laboratorium radio
logi pengalaman klinik dan lain-lain. (Bab 1.2 Statistika 
Kedokteran)

6. 	 A
	 Uji komparasi merupakan uji hipotesis untuk mengetahui 

signifikan/kemaknaan perbedaan pada suatu variabel ke­
lompok sampel penelitian. (Bab 1.3 Uji Komparasi)

7. 	 D
	 Uji komparasi dibedakan menjadi dua, yaitu uji komparasi 

untuk statistik parametrik dan statistik non-parametrik. 
(Bab 1.3 Uji Komparasi)

8. 	 D
	 Syarat penggunaan uji komparasi parametik adalah jenis 

data kuantitatif, skala data interval dan rasio, berdistribusi 
normal dan sampel minimal 30. (Bab 1.3 Uji Komparasi)



Komparasi Parametrik 
dan Non-Parametrik 21

9. 	 E
	 Syarat penggunaan uji non-komparasi parametik adalah 

jenis data kuantitatif, skala data interval dan rasio, ber
distribusi normal dan sampel minimal 30. (Bab 1.3 Uji 
Komparasi)

10. 	 A
	 Syarat penggunaan uji komparasi parametik adalah jenis 

data kuantitatif, skala data interval dan rasio, berdistribusi 
normal dan sampel minimal 30. (Bab 1.3 Uji Komparasi)

11. 	 E
	 Syarat penggunaan uji non-komparasi parametik adalah 

jenis data kuantitatif, skala data interval dan rasio, 
berdistribusi normal dan sampel minimal 30. (Bab 1.3 Uji 
Komparasi)

12. 	 A
	 One-way Anova adalah uji perbandingan rerata untuk 

dua sampel atau lebih dengan satu jalan/faktor, diguna
kan analisis varian/ANOVA satu jalan (Bab 1.3 Uji 
Komparasi).

13. 	 E
	 Uji Chi Square merupakan uji perbandingan yang diguna

kan apabila uji komparasi parametrik tidak memenuhi 
persyaratan (data berdistribusi normal). (Bab 1.3 Uji 
Komparasi)

14. 	 C
	 Uji Wilcoxon merupakan uji alternatif perbandingan 

rerata untuk dua sampel yang saling berhubungan. 
Uji tersebut digunakan apabila uji Paired T-test tidak 
memenuhi persyaratan (data berdistribusi normal). (Bab 
1.3 Uji Komparasi)
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15. 	 B
	 Uji Chi Square 1 sampel merupakan uji komparasi yang 

digunakan untuk mengetahui perbedaan dengan meng
gunakan 1 variabel dibandingkan dengan nilai standar.  
(Bab 1.3 Uji Komparasi)

16. 	 C
	 Hipotesis merupakan gabungan dari kata “Hipo” yang 

artinya dibawah dan “tesis” artinya kebenaran. Secara 
keseluruhan hipotesis berarti di bawah kebenaran (belum 
tentu benar). (Bab 1.4 Hipotesis)

17. 	 D
	 Secara keseluruhan hipotesis berarti di bawah kebenaran 

(belum tentu benar) dan baru dapat diangkat menjadi 
suatu kebenaran jika memang telah disertai dengan bukti-
bukti. Hipotesis merupakan jawaban sementara terhadap 
masalah penelitian yang kebenarannya harus diuji secara 
empiris. (Bab 1.4 Hipotesis)

18. 	 A
	 Landasan teori merupakan langkah penting untuk mem

bangun sebuah hipotesis. Landasan teori yang dipilih 
haruslah sesuai dengan ruang lingkup permasalahan. 
Landasan teoretis akan menjadi suatu asumsi dasar 
peneliti dan sangat berguna pada saat menentukan suatu 
hipotesis penelitian. (Bab 1.4 Hipotesis)

19. 	 E
	 Hipotesis penelitian dapat dirumuskan melalui 2 jalur, 

yaitu
	 l 	Membaca dan menelaah ulang (review) teori dan kon- 
		  sep yang membahas  variabel penelitian  dan hubung- 
		  annya dengan proses berpikir deduktif.
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	 l 	Membaca dan  me-review temuan-temuan  penelitian 
		  terdahulu yang  relevan dengan  penelitian lewat ber- 
		  pikir induktif.
		  (Bab 1.4 Hipotesis)

20. 	 B
	 Hipotesis terdiri dari H0 dan H1 dengan pola sebagai 

berikut
	 l 	H0: Tidak ada perbedaan perlakuan pertama dan kedua
	 l 	H1: Ada perbedaan perlakuan pertama dan kedua
	 (Bab 1.4 Hipotesis)

21. 	 E
	 Terdapat 2 jenis kesalahan yang sering terjadi ketika 

pengujian Hipotesis. Ketika hipotesis nol (H0) ditolak, 
padahal hipotesis nol itu benar, kesalahan tersebut disebut 
kesalahan jenis I atau type error I. Sedangkan apabila 
hipotesis nol (H0) diterima, padahal hipotesis tersebut 
salah disebut kesalahan jenis II atau type error II. (Bab 
1.4 Hipotesis)

22. 	 B
	 Terdapat 2 jenis kesalahan yang sering terjadi ketika 

pengujian Hipotesis. Ketika hipotesis nol (H0) ditolak, 
padahal hipotesis nol itu benar, kesalahan tersebut disebut 
kesalahan jenis I atau type error I. Sedangkan apabila 
hipotesis nol (H0) diterima, padahal hipotesis tersebut 
salah disebut kesalahan jenis II atau type error II. Apabila 
hipotesis yang dihasilkan oleh penelitian tersebut sesuai, 
maka dapat dikatakan bahwa penelitian itu memiliki 
keputusan yang tepat. (Bab 1.4 Hipotesis)

23. 	 B
	 Terdapat 2 jenis kesalahan yang sering terjadi ketika 

pengujian Hipotesis. Ketika hipotesis nol (H0) ditolak, 
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padahal hipotesis nol itu benar, kesalahan tersebut disebut 
kesalahan jenis I atau type error I. Sedangkan apabila 
hipotesis nol (H0) diterima, padahal hipotesis tersebut 
salah disebut kesalahan jenis II atau type error II. (Bab 
1.4 Hipotesis)

24. 	 E
	 Hipotesis terdiri dari H0 dan H1 dengan pola sebagai 

berikut
	 l 	H0: Tidak ada perbedaan perlakuan pertama dan kedua
	 l 	H1: Ada perbedaan perlakuan pertama dan kedua
	 Sehingga dapat disimpulkan bahwa tidak ada perbedaan 

hasil tekanan darah antara mengkonsumsi herbal dan obat 
konvensional.

	 (Bab 1.4 Hipotesis)

25. 	 A
	 Hipotesis terdiri dari H0 dan H1 dengan pola sebagai 

berikut
	 l 	H0: Tidak ada perbedaan perlakuan pertama dan kedua
	 l 	H1: Ada perbedaan perlakuan pertama dan kedua
	 Sehingga dapat disimpulkan bahwa terdapat perbedaan 

BB sebelum dan sesudah menggunakan herbal.
	 (Bab 1.4 Hipotesis)
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UJI KOMPARASI 
PARAMETRIK2

Latar Belakang
Uji komparasi parametrik merupakan suatu analisis 

data yang digunakan untuk mengetahui perbedaan kedua 
data penelitian dengan skala data parametrik. Penggunaan 
uji komparasi juga terdapat beberapa persyaratan yang akan 
menentukan jenis uji yang digunakan. 

Mahasiswa kedokteran diharapkan mampu untuk mema
hami dan menggunakan uji komparasi parametrik serta da
pat menginterpretasikan secara benar dan tepat. Kesalahan 
dalam menggunakan dan menginterpretasikan uji komparasi 
parametrik akan berpengaruh pada hasil penelitian dan kesim
pulan dari suatu penelitian.

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 
dapat mengetahui dan memahami tentang uji komparasi parametrik.
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dengan cara membandingkan nilai atau data penelitian yang 
diperoleh dengan nilai rerata yang telah menjadi standar atau 
nilai acuan penelitian. Prasyarat awal penggunaan uji T-test 
satu sampel adalah data penelitian yang telah diperoleh harus 
dilakukan uji normalitas terlebih dahulu dengan nilai p value 
lebih besar dari 0,05. Berikut contoh soal yang menggunakan 
uji T-test Satu Sampel.

Studi Kasus:
Seorang dosen mendapatkan nilai ujian metode penelitian 

pada 15 mahasiswa semester 5, Fakultas Kedokteran, Univer
sitas Surabaya. Dosen tersebut ingin melihat apakah nilai 
yang diperoleh mahasiswa memiliki perbedaan dengan batas 
minimal kelulusan yang ditetapkan oleh Universitas Surabaya. 

(Batas Nilai Minimal = 55; Tingkat Kepercayaan = 95%).
Berikut data nilai mahasiswa Fakultas Kedokteran, Universitas 
Surabaya.
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3. 	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.3 Tampilan Uji Normalitas pada SPSS. 



Komparasi Parametrik 
dan Non-ParametrikUji Komparasi Parametrik30

Hasil Uji Normalitas

Gambar 2.4 Tampilan hasil Uji Normalitas.

Pada hasil uji normalitas memperlihatkan nilai Shapiro-
Wilk memiliki Sig 0,757 (p value>0,05), sehingga dapat 
disimpulkan data nilai ujian metode penelitian mahasiswa 
semester 5, Fakultas Kedokteran, Universitas Surabaya 
berdistribusi Normal. Dengan demikian, dapat dilakukan 
pengujian dengan menggunakan T-test 1 sampel.

NB: 	Jumlah sampel kurang dari 50, sehingga nilai p-value pa- 
	 da uji Shapiro-Wilk yang digunakan untuk menilai.
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4. 	 Klik Analyze → Compare Means → One Sample T-Test

Gambar 2.5 Tampilan analyze data pada SPSS.

5. 	 Masukkan Nilai Mahasiswa pada kolom Test Variabel; 
Batas nilai minimal mahasiswa (Nilai:55) pada Test 
Value; Klik “OK”

Gambar 2.6 Tampilan One-Sample T Test pada SPSS. 
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tidak berpasangan adalah data memiliki distribusi normal (p 
value>0,05). Apabila persyaratan tersebut tidak dapat dipenuhi 
maka dapat dilakukan uji alternatif lainnya yaitu Uji Mann 
Whitney.

Sebagai contoh yang dimaksud dengan sampel yang tidak 
berpasangan adalah membandingkan tingkat pengetahuan 
masyarakat di Desa A dengan Desa B mengenai Perilaku 
Hidup Bersih dan Sehat (PHBS) setelah dilakukan penyuluhan 
oleh Dinas Kesehatan Kota Surabaya. 

Penggunaan uji T-test sampel tidak berpasangan tidak 
hanya digunakan pada penelitian eksperimental atau intervensi, 
namun lebih pada perbedaan antar sampel penelitian. 

Studi Kasus:
Seorang mahasiswa kedokteran Universitas Surabaya 

melakukan penyuluhan mengenai pentingnya Pemberian 
ASI Eksklusif pada 10 Wanita Usia Subur di dua kecamatan. 
Kecamatan pertama dilakukan dengan metode penyuluhan 
berupa ceramah, sedangkan kecamatan kedua dilakukan me
tode penyuluhan berupa permainan berkelompok. Setelah 
dilakukan penyuluhan, peserta diberikan kuesioner yang 
berisi beberapa pertanyaan untuk melihat tingkat pemahaman 
masing-masing. Hasil kuesioner dari kedua kecamatan dilaku
kan analisis untuk melihat adanya perbedaan terhadap metode 
yang digunakan.
(Range nilai pada kuesioner tersebut adalah 0-100)
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Berikut data nilai kuesioner dari dua kecamatan setelah dila
kukan penyuluhan.

Prosedur:
1. 	 Masukkan nama variabel “Kecamatan” dan “Nilai 

Kuisioner” pada Variable View. 

Gambar 2.8 Tampilan variable view pada SPSS.
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2. 	 Berikan koding pada kelompok Desa pada Value Labels.

Gambar 2.9 Tampilan value labels pada SPSS. 

3. 	 Masukkan data nilai kuisioner pada Data View

Gambar 2.10 Tampilan data view pada SPSS.
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4. 	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.11 Tampilan Uji Normalitas pada SPSS.
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Hasil Uji Normalitas

Gambar 2.12 Tampilan hasil Uji Normalitas.

Pada hasil uji normalitas memperlihatkan nilai Shapiro-
Wilk pada desa A memiliki Sig. 0,243 (p value>0,05) dan 
Desa B memiliki Sig. 0,473 (p value>0,05), sehingga dapat 
disimpulkan data tersebut Berdistribusi Normal. Dengan 
demikian, dapat dilakukan proses pengujian selanjutnya.

5. 	 Klik Analyze → Compare Means → Independent 
Samples T-test

Gambar 2.13 Tampilan analisis data pada SPSS.
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6. 	 Masukkan Nilai_Pengetahuan ke kolom Test Variable; 
Masukkan Variable Desa ke kolom Grouping Variable

Gambar 2.14 Tampilan Independent-Sample T Test pada SPSS.

7. 	 Klik Define Group, Tuliskan angka “1” dan “2” Sesuai 
dengan koding kelompok Desa pada Value Label (Lihat 
Nomer 1)

Gambar 2.15 Tampilan value label pada SPSS.
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Prosedur:
1. 	 Masukkan nama variabel “Sebelum Penyuluhan” dan 

“Sesudah Penyuluhan” pada Variable View.

Gambar 2.17 Tampilan variable view pada SPSS. 

2. 	 Masukkan data nilai kuisioner sebelum dan sesudah 
penyuluhan pada Data View

Gambar 2.18 Tampilan data view pada SPSS.
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3. 	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.19 Tampilan Uji Normalitas pada SPSS.
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Hasil Uji Normalitas

Gambar 2.20 Hasil Uji Normalitas.

Pada hasil uji normalitas memperlihatkan nilai Shapiro-
Wilk pada sebelum penyuluhan memiliki Sig. 0,516 (p 
value>0,05) dan sesudah penyuluhan memiliki Sig. 0,196 
(p value>0,05), sehingga dapat disimpulkan data tersebut 
Berdistribusi Normal. Dengan demikian, dapat dilakukan 
proses pengujian selanjutnya.

4. 	 Klik Analyze → Compare Means → Paired Samples T-test

Gambar 2.21 Tampilan analyze data pada SPSS.
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Gambar 2.24 Hasil Paired Samples Correlations.

Pada tabel kedua memperlihatkan hubungan atau kore
lasi antara kedua kelompok. Diketahui terdapat hubungan 
yang signifikan pada kedua kelompok yaitu nilai p=0,022 
(p value<0,05). Namun untuk menentukan seberapa besar 
hubungan antara kedua kelompok, maka dapat melihat nilai 
correlation yaitu 0,709 (Penjelasan lebih lanjut mengenai Uji 
Korelasi). 

Gambar 2.25 Hasil Paired Samples Test.

Pada tabel tiga memperlihatkan hasil uji T-test 2 sampel 
berpasangan yang diketahui memiliki nilai sig. (2-tailed) 
yaitu 0,121 (p value>0,05), sehingga dapat disimpulkan tidak 
adanya perbedaan tingkat pemahaman wanita usia subur di 
Desa A sebelum dan sesudah dilakukan penyuluhan.

2.4 	 One Way Anova
Suatu uji komparasi yang digunakan untuk mengetahui 

perbedaan antara lebih dari 2 kelompok sampel yang saling 
bebas atau independent. Pada uji ini memiliki tiga prasyarat 
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Berikut data nilai kadar malondialdehid pada ketiga kelompok:

Prosedur:
1. 	 Masukkan nama variabel “Kelompok” dan “Nilai 

Malondialdehid” pada Variable View.

Gambar 2.26 Tampilan variable view pada SPSS.
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2. 	 Berikan koding pada kelompok penelitian (Kontrol 
negatif, Positif Rokok dan Perlakuan pada Value Labels.

Gambar 2.27 Tampilan value labels pada SPSS.

3. 	 Masukkan Data kelompok dan nilai malondialdehid pada 
data view

Gambar 2.28 Tampilan data view pada SPSS.
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4. 	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.29 Tampilan Uji Normalitas pada SPSS.
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Hasil Uji Normalitas

Gambar 2.30 Hasil Uji Normalitas.

Pada hasil uji normalitas memperlihatkan nilai Shapiro-
Wilk pada kelompok kontrol negatif memiliki sig. 0,871, 
kelompok positif rokok memiliki sig. 0,091 dan kelompok 
perlakuan memiliki sig. 0,946 (p value>0,05), sehingga 
dapat disimpulkan semua data tersebut Berdistribusi 
Normal. Dengan demikian, dapat dilakukan proses pengujian 
selanjutnya.
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6. 	 Masukkan Nilai_Malondialdehid pada Dependent List 
dan Kelompok pada Factor

Gambar 2.32 Tampilan One-way Anova pada SPSS.

7. 	 Klik Options → “Homogeneity of variance test”

Gambar 2.33 Tampilan Homogeneity of Variance Test pada SPSS.
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9. 	 Pengujian antar-kelompok dengan menggunakan uji 
Least Significant Differences (LSD). Klik Post Hoc → 
Pilih LSD

Gambar 2.36 Tampilan Least Significant Differences pada SPSS.

10. 	 Hasil Uji Least Significant Differences (LSD)

Gambar 2.37 Hasil Least Significant Differences. 
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Prosedur Pengujian Normalitas (Nilai Residual):
1. 	 Masukkan nama variabel “Pelayanan Administrasi”, “Ke

bersihan Ruang Tunggu” dan “Kepuasan Pasien” pada 
Variable View

Gambar 2.38 Tampilan variable view pada SPSS.

2. 	 Berikan koding pada Pelayanan Administrasi (Baik dan 
buruk) dan Kebersihan Ruang Tunggu (Bersih, Cukup, 
dan Kotor) pada Value Labels



Komparasi Parametrik 
dan Non-Parametrik 6151Uji Komparasi Parametrik58

Gambar 2.39 Tampilan value labels pada SPSS.

3. 	 Masukkan Data “Pelayanan Administrasi”, “Kebersihan 
Ruang Tunggu” dan “Kepuasan Pasien” pada data view.

Gambar 2.40 Tampilan data view pada SPSS.



Komparasi Parametrik 
dan Non-Parametrik 59

4. 	 Klik Analyze → General Linear Model → Univariate

Gambar 2.41 Tampilan analyze data pada SPSS.

5. 	 Masukkan data sampel pada kolom “Dependent Variable” 
dan “Fixed Factor”

Gambar 2.42 Tampilan dependent variable pada SPSS.
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8. 	 Klik Analyze → Descriptive Statistics → Explore

Gambar 2.45 Tampilan analyze data pada SPSS. 

9. 	 Masukkan ZRE_1 atau Standardized Residual for Hasil 
ke kotak Dependent List → Klik Plots

Gambar 2.46 Tampilan Standardized Residual pada SPSS.
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Prosedur Pengujian Two Way Anova:
1. 	 Setelah melakukan Uji Normalitas, selanjutnya klik 

Analyze → General Linear Model → Univariate

Gambar 2.49 Tampilan Analyze Data pada SPSS. 

2. 	 Masukkan data sampel pada kolom “Dependent Variable” 
dan “Fixed Factor”

Gambar 2.50 Tampilan Dependent Variable pada SPSS.
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3. 	 Klik Plots → Masukkan pada kolom “Horizontal Axis” 
dan “Separate Lines”

Gambar 2.51 Tampilan Univariate Profile Plots pada SPSS. 

4. 	 Klik Post Hoc; Masukkan kelompok sampel ke Post Hoc 
Test for

Gambar 2.52 Tampilan Univariate Post Hoc pada SPSS.
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c. 	 Pelayanan_Administrasi:
	 Nilai pengaruh pelayanan administrasi terhadap nilai 

kepuasan pada model. Nilai sig. adalah 0,000 (p 
value<0,05), sehingga dapat disimpulkan pelayanan 
administrasi berpengaruh signifikan.

d. 	 Kebersihan_Ruang_Tunggu:
	 Nilai pengaruh kebersihan ruang tunggu terhadap 

nilai kepuasan pada model. Nilai sig. adalah 0,000 (p 
value<0,05), sehingga dapat disimpulkan kebersihan 
ruang tunggu berpengaruh signifikan.

e. 	 Pelayanan_Administrasi*Kebersihan_Ruang_Tunggu
	 Pengaruh pelayanan administrasi dan kebersihan ruang 

tunggu terhadap nilai kepuasan pada model tersebut. 
Nilai sig. adalah 0,039 (p value<0,05), sehingga dapat 
disimpulkan pelayanan administrasi dan kebersihan ruang 
tungg berpengaruh signifikan.

f. 	 Error:
	 Nilai Error pada model. Nilai error semakin kecil, maka 

model semakin baik

g. 	 R Squared:
	 Nilai determinasi berganda pada semua variabel 

independent dengan dependen. Nilai R Squared adalah 
0,949 (nilai mendekati 1), memiliki korelasi kuat.
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8. 	 Diagram Plot

Gambar 2.56 Hasil diagram plot.

Diagram ini bertujuan untuk melakukan salah satu peni
laian adanya interaksi antar-variabel (tidak mutlak, hanya 
memberikan gambaran). Bila garis-garis tersebut tidak menun
jukkan kesejajaran, maka dapat dipertimbangkan adanya efek 
interaksi.

2.6 	 Kolmogorov Smirnov Satu Sampel (Goodness of Fit)
Suatu uji yang digunakan untuk menganalisis perbedaan 

pada satu sampel. Penggunaan uji ini sama dengan uji 
normalitas, yang biasanya digunakan untuk mengetahui data 
variabel berdistribusi normal atau tidak. Pada uji komparasi 
parametrik, uji ini merupakan salah satu prasyarat awal. 
Apabila data satu sampel tersebut memiliki distribusi normal 
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4. 	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.60 Tampilan Uji Normalitas.
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6. 	 Masukkan Nilai_Pengetahuan ke kolom Test Variable; 
Masukkan Variabel Desa ke kolom Grouping Variable 

Gambar 2.63 Tampilan Two-Independent Sample Test pada SPSS.

7. 	 Klik Define Group, Tuliskan angka “1” dan “2” Sesuai 
dengan koding kelompok Desa pada Value Label (Lihat 
Nomer 1)

Gambar 2.64 Tampilan value labels pada SPSS.
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3.	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.68 Tampilan Uji Normalitas pada SPSS. 
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4. 	 Klik Analyze → Nonparametric Tests → Legacy Dialogs 
→ 2 Related Samples

Gambar 2.70 Tampilan analyze data pada SPSS.

5. 	 Masukkan Nilai Sebelum dan sesudah Penyuluhan ke 
dalam kolom Test Pars

Gambar 2.71 Tampilan Two Related Sample Test pada SPSS.
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6. 	 Hasil Uji Wilcoxon

Gambar 2.72 Hasil Uji Wilcoxon.

Pada Tabel pertama memperlihatkan distribusi frekuensi 
dari data penelitian yaitu nilai rerata dari kedua kelompok 
(mean) dan Jumlah sampel pada setiap kelompok (N). 
Walaupun ada perbedaan nilai rerata kedua kelompok, namun 
belum dapat dibuktikan perbedaan tersebut signifikan.

Pada tabel kedua memperlihatkan hasil uji wilcoxon 
yang diketahui memiliki nilai sig. (2-tailed) yaitu 0,593 (p 
value>0,05), sehingga dapat disimpulkan tidak adanya per
bedaan tingkat pemahaman ibu terkait pentingnya melakukan 
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3. 	 Masukkan Data kelompok dan nilai malondialdehid pada 
data view

Gambar 2.75 Tampilan data view pada SPSS.
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4. 	 Lakukan Uji Normalitas terlebih dahulu

Gambar 2.76 Tampilan Uji Normalitas pada SPSS.
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Berdistribusi Normal. Dengan demikian, dapat dilakukan 
proses pengujian Kruskal Wallis.

5. 	 Klik Analyze → Nonparametric Tests → Legacy Dialogs 
→ K Independent Samples

Gambar 2.79 Tampilan analyze data pada SPSS.

6. 	 Masukkan Nilai_Malondialdehid pada Dependent List 
dan Kelompok pada Factor

Gambar 2.80 Tampilan Independent Samples pada SPSS.
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7. 	 Klik Options → “Homogeneity of variance test”

Gambar 2.81 Tampilan Homogeneity of Variance Test pada SPSS.
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Prosedur:
1. 	 Masukkan nama variabel “Berat_Badan_Awal”, “Berat_

Badan_Bulan 1” dan “Berat_Badan_Bulan 2” pada 
Variable View.

Gambar 2.83 Tampilan variable view pada SPSS.

2. 	 Masukkan Data Berat Badan pada data view

Gambar 2.84 Tampilan data view pada SPSS.
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Klik “Add”.

Gambar 2.87 Tampilan measures define factors II pada SPSS.

Klik “Define”, pindahkan ketiga kelompok berat badan ke 
Within-Subjects Variables.

Gambar 2.88 Tampilan repeated measures pada SPSS.
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Klik “Save”, kemudian klik “Standardized”

Gambar 2.89 Tampilan repeated measures save pada SPSS.

Klik “Continue”, lanjut klik “OK”, pada data view akan 
muncul output yang disebut sebagai Standardized Residual

Gambar 2.90 Tampilan Standardized Residual pada SPSS.
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Klik Analyze → Descriptive Statistics → Explore

Gambar 2.91 Tampilan analyze data pada SPSS.

Masukkan data Standarized Residual pada Dependent List, 
klik Plots pilih “Normality plots with tests” 

Gambar 2.92 Tampilan explore plots pada SPSS.
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4. 	 Klik Analyze → Nonparametric Tests → Legacy Dialogs 
→ K Related Samples

Gambar 2.94 Tampilan analyze data pada SPSS.

5. 	 Masukkan ketiga kelompok pada Test Variables, klik 
“Friedman”

Gambar 2.95 Tampilan Tests for Several Related Samples pada SPSS.
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Tabel Kedua memperlihatkan rerata atau mean pada 
varians dalam bentuk ranking yaitu kelompok berat badan 
awal (1,87), kelompok kontrol positif (2,03) dan kelompok 
perlakuan (2,10). 

Tabel ketiga memperlihatkan hasil uji Friedman pada 
data penelitian yaitu 0,793 (p value>0,05). Kesimpulan data 
penelitian ini adalah tidak adanya perbedaan berat badan yang 
signifikan pada ketiga kelompok penelitian. Selain itu, langkah 
lainnya juga dapat dilakukan melalui perbandingan nilai Chi-
Square dengan nilai tabel Chi-Square (Langkah pertama lebih 
mudah dilakukan).
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prasyarat dari kedua data tersebut diperoleh bahwa data 
berdistribusi normal dan bersifat heterogen. Uji komparasi 
yang paling sesuai adalah:

	 a.	 Uji One-Way Anova
	 b.	 Uji Kolmogorov Smirnov
	 c.	 Uji T-test 1 sampel
	 d.	 Uji T-test Berpasangan
	 e.	 Uji T-test tidak Berpasangan

20.	 Dokter puskesmas melakukan pemberian makanan 
tambahan untuk balita gizi buruk. Pemberian makanan 
tersebut dilakukan selama 3 bulan. Dokter melakukan 
penimbangan awal bulan, bulan pertama, bulan kedua 
dan bulan ketiga. Jumlah balita yang mendapat makanan 
tambahan sebanyak 15 orang. Data yang diperoleh sebagai 
berikut.
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	 Setelah dilakukan uji normalitas didapatkan data tersebut 
tidak berdistribusi normal. Uji komparasi yang dilakukan 
oleh mahasiswa adalah:

	 a.	 Shapiro-Wilk
	 b.	 Mann-Whitney
	 c.	 Wilcoxon
	 d.	 Kruskal-Wallis
	 e.	 Friedman

26.	 Tim kesehatan dari pemerintah daerah ingin mengetahui 
adanya perbedaan kadar C-Reactive Protein pada pasien 
penderita Covid-19 di Rumah Sakit Umum Daerah terha
dap pemberian terapi dengan 3 jenis obat berbeda.

25.	 Mahasiswa kedokteran semester 8 mengerjakan tugas 
akhir dengan mengambil data sekunder dari Rumah Sa
kit Umum Daerah. Data yang diambil merupakan per
kembangan peningkatan kadar trombosit pada hari ke-3, 
5, dan 7 setelah pemberian ekstrak jambu biji. Data ter
sebut akan dilakukan uji komparasi untuk melihat adanya 
perbedaan antar kelompok. Hasil yang diperoleh sebagai 
berikut.
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	 a.	 Anova Two Way
	 b.	 Kolmogorov Smirnov
	 c.	 T-test
	 d.	 Friedman
	 e.	 Mann-Whitney

JAWABAN DAN PEMBAHASAN

1.	 A
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengukuran dilakukan sebe
lum dan sesudah intervensi, sehingga uji komparasi yang 
paling sesuai adalah Uji T-test. 

2.	 C
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengukuran dilakukan pada 
1 kelompok dengan Batasan nilai yang dibandingkan 
sebesar 66, sehingga uji komparasi yang paling sesuai 
adalah Uji T-test satu sampel. 

3.	 D
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengukuran dilakukan sebe
lum dan sesudah intervensi pemberian asupan gizi, se
hingga uji komparasi yang paling sesuai adalah Uji T-test 
berpasangan. 

4.	 E
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengukuran tinggi badan 
dan berat badan yang tidak memiliki keterkaitan atau 
hubungan antar keduanya, sehingga uji komparasi yang 
paling sesuai adalah Uji T-test tidak berpasangan. 
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5.	 A
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengetahuan dengan tingkat 
pendidikan yang dibagi menjadi 3 kategori (tidak pernah 
bersekolah, lulusan sekolah dasar dan lulusan di atas 
sekolah dasar), sehingga uji komparasi yang paling sesuai 
adalah Uji Anova one way. 

6.	 B
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan 3 kelompok yaitu jenis kelamin 
(pria dan wanita), lulusan Pendidikan (D3, S1, dan di atas 
S1) dan tingkat kepuasan, sehingga uji komparasi yang 
paling sesuai adalah Uji Anova two way. 

7.	 C
	 Interpretasi pada pernyataan tersebut adalah
	 a.	 Kadar  malondialdehid  dengan satuan µmol/L mem- 
		  perlihatkan skala data adalah ratio.
	 b.	 Persyaratan mutlak pada uji ANOVA adalah data ber- 
		  distribusi normal dan bersifat homogen.
	 c.	 Hasil  uji  normalitas  memperlihatkan p=0,634 yang 
		  berarti tidak ada perbedaan atau berdistribusi normal.
	 d.	 Hasil uji homogenitas memperlihatkan p=0,142 yang 
		  berarti adanya perbedaan atau homogen.
	 e.	 Hasil uji ANOVA memperlihatkan p=0,063 yang ber- 
		  arti tidak adanya  perbedaan atau  tidak signifikan an- 
		  tar kelompok.

8.	 E
	 Interpretasi pada pernyataan tersebut adalah
	 a.	 Persyaratan mutlak pada uji T-test adalah data berdis- 
		  tribusi normal saja.
	 b.	 Hasil  uji  normalitas  memperlihatkan p=0,339 yang 
		  berarti tidak ada perbedaan atau berdistribusi normal.
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	 b.	 Hasil uji homogenitas memperlihatkan p=0,044 yang 
		  berarti  adanya  perbedaan  atau  tidak  homogen  atau 
		  heterogen.
	 d.	 Hasil uji T-test berpasangan memperlihatkan p=0,021 
		  yang berarti  adanya  perbedaan  atau signifikan antar- 
		  kelompok.

9.	 C
	 Interpretasi pada pernyataan tersebut adalah
	 a.	 Penggunaan  uji  T-test  digunakan  untuk  skala  data 
		  parametrik.
	 b.	 Syarat  mutlak  uji  T-test hanya berdistribusi normal, 
		  sedangkan  uji  homogenitas  dapat bersifat homogen 
		  dan heterogen.
	 c.	 Penelitian  dilakukan  sebanyak 2 kali yaitu awal dan 
		  akhir bulan (2 kelompok).
	 d.	 Pada penelitian tidak memerlukan kelompok kontrol.

10.	 E
	 Pada penelitian pengukuran yang dilakukan adalah kadar 

gula darah, sehingga dapat disimpulkan skala data yang 
digunakan adalah parametrik. Penelitian juga membagi 
2 kelompok yaitu kelompok kontrol dan kelompok 
perlakuan, sehingga dapat disimpulkan bahwa tidak 
ada hubungan (berpasangan) antar-kedua kelompok. 
Oleh karena itu dapat disimpulkan uji komparasi 
yang digunakan pada penelitian ini adalah T-test tidak 
berpasangan.

11.	 E
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengukuran dilakukan 
pada kedua desa yang berbeda atau tidak berhubungan, 
sehingga uji komparasi yang paling sesuai adalah Uji 
T-test tidak berpasangan. 
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12.	 E
	 Interpretasi pada pernyataan tersebut adalah
	 a.	 Jumlah sel  PMN pada  jaringan histologi paru mem- 
		  perlihatkan skala data adalah ratio.
	 b.	 Persyaratan mutlak pada uji ANOVA adalah data ber- 
		  distribusi normal dan bersifat homogen.
	 c.	 Hasil  uji  normalitas  memperlihatkan p=0,032 yang 
		  berarti  adanya   perbedaan   atau  tidak  berdistribusi 
		  normal.
	 d.	 Hasil uji homogenitas memperlihatkan p=0,129 yang 
		  berarti tidak adanya perbedaan atau homogen.
	 e.	 Hasil uji ANOVA memperlihatkan p=0,011 yang ber- 
		  arti adanya perbedaan signifikan antar kelompok.
	 Oleh karena itu, persyaratan uji ANOVA tidak terpenuhi, 

dikarenakan data tidak berdistribusi normal

13.	 E
	 Skala data pada penelitian ini adalah parametrik. Pada 

penelitian memperlihatkan pengukuran dilakukan sebe
lum dan sesudah intervensi, sehingga uji komparasi yang 
paling sesuai adalah Uji T-test berpasangan. 

14.	 C
	 l	 Pengukuran berat badan pada penelitian memperlihat- 
		  kan  bahwa  skala   data  pada   penelitian  ini  adalah 
		  parametrik. 
	 l	 Pengukuran  dilakukan  untuk  membandingkan berat 
		  badan pada awal bulan dengan berat badan standar.
	 Oleh  karena  itu,  uji  komparasi  yang  paling  sesuai 

adalah uji T-test 1 sampel.

15.	 D
	 l	 Pengukuran berat badan pada penelitian 
		  memperlihatkan bahwa skala data pada penelitian ini 
		  adalah parametrik. 
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	 l	 Pengukuran  dilakukan  untuk membandingkan berat 
		  badan  pada  awal  bulan  dengan  berat  badan  bulan 
		  ketiga.
	 Oleh karena itu, uji komparasi yang paling sesuai adalah 

uji T-test sampel berpasangan.

16.	 A
	 l	 Pengukuran  berat  badan  pada  penelitian  memperli- 
		  hatkan bahwa  skala data  pada  penelitian  ini adalah 
		  parametrik. 
	 l	 Pengukuran  dilakukan  untuk  membandingkan berat 
		  badan awal, berat  badan  bulan pertama, berat badan 
		  bulan kedua dan berat badan bulan ketiga.
	 Oleh karena itu, uji komparasi yang paling sesuai adalah 

uji One-way ANOVA.

17.	 B
	 l	 Pengukuran  berat  badan  pada penelitian memperli- 
		  hatkan bahwa  skala data  pada  penelitian  ini adalah 
		  parametrik. 
	 l	 Pengukuran dilakukan  untuk  membandingkan berat 
		  badan awal, dan bulan kedua.
	 l	 Uji komparasi yang paling sesuai adalah T-test sampel 
		  berpasangan.
	 Oleh karena itu, uji prasyarat yang dibutuhkan adalah uji 

normalitas (Kolmogorov Smirnov).

18.	 D
	 l	 Pengukuran  berat  badan  pada penelitian memperli- 
		  hatkan  bahwa  skala data  pada penelitian  ini  adalah 
		  parametrik. 
	 l	 Pengukuran  dilakukan  untuk  membandingkan berat 
		  badan kedua dan bulan ketiga.
	 l	 Uji komparasi yang paling sesuai adalah T-test sampel 
		  berpasangan.
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	 Oleh karena itu, uji prasyarat yang dibutuhkan adalah uji 
normalitas (Kolmogorov Smirnov) dan uji homogenitas 
(tidak mutlak)

19.	 D
	 l	 Pengukuran  berat  badan  pada penelitian memperli- 
		  hatkan bahwa skala  data pada  penelitian  ini  adalah 
		  parametrik. 
	 l	 Pengukuran dilakukan  untuk membandingkan  berat 
		  badan bulan pertama dan bulan kedua.
	 l	 Uji komparasi yang paling sesuai adalah T-test sampel 
		  berpasangan.
	 l	 Uji prasyarat yang dibutuhkan  adalah uji normalitas 
		  (Kolmogorov Smirnov).
	 l	 Uji  homogenitas  pada  pengukuran  uji  T-test  tidak 
		  mutlak dilakukan, dikarenakan T-test dapat digunakan 
		  pada data homogen dan heterogeny.

20.	 A
	 l	 Pengukuran  berat  badan  pada penelitian memperli- 
		  hatkan  bahwa  skala  data  pada penelitian ini adalah 
		  parametrik. 
	 l	 Pengukuran  dilakukan untuk  membandingkan  berat 
		  badan awal, berat  badan  bulan pertama, berat badan 
		  bulan kedua dan berat badan bulan ketiga.
	 l	 Uji prasyarat yang mutlak adalah uji normalitas 
		  (berdistribusi normal) dan uji homogenitas (homogen),
	 Oleh karena itu, uji komparasi yang paling sesuai adalah 

uji One-way ANOVA.

21.	 B
	 Pada penelitian tersebut memperlihatkan skala data 

berupa ratio. Pada pembagian kedua kelompok bukanlah 
berpasangan, dikarenakan antar-kelompok tidak memiliki 
keterkaitan (bebas) yaitu kelompok pra-nikah dan ibu 
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hamil. Pada uji normalitas juga memperlihatkan data 
tidak berdistribusi normal, sehingga uji komparasi yang 
tepat adalah uji Mann-Whitney.

22.	 C
	 Pada penelitian tersebut memperlihatkan skala data berupa 

ratio. Pada pembagian kedua kelompok memperlihatkan 
adanya hubungan kedua kelompok  yaitu kelompok sebe
lum dan sesudah pendampingan. Pada uji normalitas juga 
memperlihatkan data tidak berdistribusi normal, sehingga 
uji komparasi yang tepat adalah uji Wilcoxon.

23.	 A
	 Pada kedua data tersebut memperlihatkan skala data rasio 

(dikatakan nilai range nilai 0-100). Data yang diujikan 
tidak memiliki keterkaitan antar kedua-nya. Pada uji 
normalitas juga memperlihatkan data tidak berdistribusi 
normal, sehingga uji komparasi yang tepat adalah uji 
Mann-Whitney.

24.	 C
	 Pada kedua data tersebut memperlihatkan skala data rasio 

(dikatakan nilai range nilai 0-100). Data yang diujikan 
memiliki keterkaitan antar kedua-nya, yaitu nilai sebelum 
dan sesudah penyuluhan. Pada uji normalitas juga 
memperlihatkan data tidak berdistribusi normal, sehingga 
uji komparasi yang tepat adalah uji Wilcoxon.

25.	 E
	 Pada penelitian tersebut memperlihatkan skala data berupa 

ratio. Pada pembagian ketiga kelompok memperlihatkan 
adanya hubungan antar-kelompok (kelompok lebih dari 
2). Pada uji normalitas juga memperlihatkan data tidak 
berdistribusi normal, sehingga uji komparasi yang tepat 
adalah uji Friedman.
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26.	 D
	 Pada penelitian tersebut memperlihatkan skala data berupa 

ratio. Pada pembagian ketiga kelompok memperlihatkan 
tidak adanya hubungan antar kelompok (kelompok lebih 
dari 2). Pada uji normalitas juga memperlihatkan data 
tidak berdistribusi normal, sehingga uji komparasi yang 
tepat adalah uji Kruskal Wallis.

27.	 A
	 Uji semi kuantitatif dapat digunakan pada skala data 

ordinal, interval dan rasio.

28.	 E
	 Uji Kruskal Wallis merupakan uji kuantitatif, sehingga 

digunakan pada data yang tidak berdistribusi normal. 
Uji homogenitas tidak dibutuhkan dalam persyaratan uji 
tersebut. Skala data yang memenuhi persyaratan uji adalah 
ordinal (non-parametrik), interval dan rasio (parametrik). 
Selain itu, uji tersebut digunakan untuk data penelitian 
yang lebih dari 2 kelompok dan tidak berpasangan 
(bebas), sehingga dapat dijadikan sebaai uji alternatif dari 
Anova One Way.

29.	 A
	 Pada keempat data kepuasan pelayanan pasien rawat 

inap tersebut memperlihatkan skala data rasio (dikatakan 
nilai range nilai 0-50). Data yang diujikan tidak memiliki 
keterkaitan antar kelompok, dikarenakan dilakukan 
pada 4 lokasi yang berbeda. Pada uji normalitas juga 
memperlihatkan data tidak berdistribusi normal, sehingga 
uji komparasi yang tepat adalah uji Kruskal-Wallis.

30.	 D
	 Pada ketiga data berat badan bayi tersebut memperlihatkan 

skala data rasio (dikatakan nilai dalam kilogram). Data 
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yang diujikan memiliki keterkaitan antar kelompok, 
dikarenakan dilakukan pada bayi yang sama dengan 
pengulangan sebanyak 3 kali. Pada uji normalitas juga 
memperlihatkan data tidak berdistribusi normal, sehingga 
uji komparasi yang tepat adalah uji Friedman.
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Latar Belakang
Uji komparasi non-parametrik merupakan suatu analisis 

data yang digunakan untuk mengetahui perbedaan kedua 
data penelitian dengan skala data non-parametrik (nominal 
dan ordinal). Penggunaan uji komparasi non-parametrik juga 
terdapat beberapa persyaratan yang akan menentukan jenis uji 
yang digunakan. 

Mahasiswa kedokteran diharapkan mampu untuk mema
hami dan menggunakan uji komparasi non-parametrik serta 
dapat menginterpretasikan secara benar dan tepat. Kesalahan 
dalam menggunakan dan menginterpretasikan uji komparasi 
non parametrik akan berpengaruh pada hasil penelitian dan 
kesimpulan dari suatu penelitian.

Tujuan Pembelajaran
Tujuan Instruksional Umum

Setelah mengikuti perkuliahan ini diharapkan mahasiswa 

UJI KOMPARASI 
NON-PARAMETRIK3



Komparasi Parametrik 
dan Non-Parametrik 137

Prosedur:
1. 	 Masukkan nama variabel “Warna Kesukaan” pada 

Variable View.

Gambar 3.1 Tampilan variable view pada SPSS.

2. 	 Berikan koding pada kelompok penelitian (Minta dan 
Tidak Minat) pada Value Labels

Gambar 3.2 Tampilan value labels pada SPSS.
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3. 	 Masukkan Data “Futsal” pada data view.

Gambar 3.3 Tampilan data view pada SPSS.

4. 	 Klik Analyze → Non Parametric Test → Legacy Dialogs 
→ Chi Square

Gambar 3.4 Tampilan analyze data pada SPSS.
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5. 	 Pindahkan data Futsal ke kolom Test Variable List 

Gambar 3.5 Tampilan Chi Square pada SPSS.

6. 	 Hasil Uji Chi Square satu sampel

Gambar 3.6 Hasil uji Chi Square.
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Berikut data hasil kategori pengetahuan pada kedua desa:

Prosedur:
1. 	 Masukkan nama variabel “Desa” dan “Pengetahuan” pa

da Variable View.

Gambar 3.7 Tampilan variable view pada SPSS.



Komparasi Parametrik 
dan Non-Parametrik 143

3. 	 Masukkan Data “Desa” dan “Pengetahuan” pada data view.

Gambar 3.9 Tampilan data view pada SPSS.

4. 	 Klik Analyze → Descriptive Statistics → Crosstabs

Gambar 3.10 Tampilan analyze data pada SPSS.
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5. 	 Masukkan kelompok data ke dalam Row dan Column

Gambar 3.11 Tampilan crosstabs pada SPSS.

6. 	 Klik Statistics → pilih Chi Square

Gambar 3.12 Tampilan crosstabs statistics pada SPSS.
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Berikut data kategori tingkat pengetahuan sebelum dan 
sesudah diberikan penyuluhan.

Prosedur:
1. 	 Masukkan nama variabel “Sebelum Penyuluhan” dan 

“Sesudah Penyuluhan” pada Variable View.

Gambar 3.14 Tampilan variable view pada SPSS.

2. 	 Berikan koding pada sebelum penyuluhan (Baik dan 
Buruk) dan sesudah penyuluhan (Baik dan Buruk) pada 
Value Labels

Gambar 3.15 Tampilan value labels pada SPSS.
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3. 	 Masukkan Data sebelum dan sesudah penyuluhan pada 
data view.

Gambar 3.16 Tampilan data view pada SPSS.

4. 	 Klik Analyze → Non Parametric Tests → Legacy Dialogs 
→ 2 Realted Samples

Gambar 3.17 Tampilan analyze data pada SPSS.
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Gambar 3.21 Tampilan value labels pada SPSS.

2. 	 Berikan koding pada kelas (Kelas A dan Kelas B) dan 
kategori nilai (Baik, Cukup dan Kurang) pada Value 
Labels
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5. 	 Masukkan kelompok data ke dalam Row dan Column

Gambar 3.24 Tampilan crosstabs pada SPSS.

6. 	 Klik Statistics → pilih Chi Square

Gambar 3.25 Tampilan crosstabs statistics pada SPSS.
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2. 	 Berikan koding pada kelompok obat (Sesuai dan Tidak 
Sesuai) pada Value Labels

Gambar 3.28 Tampilan value labels pada SPSS.

3. 	 Masukkan Data obat A, Obat B dan Obat C pada data 
view.

Gambar 3.29 Tampilan data view pada SPSS.
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4. 	 Klik Analyze → Non Parametric Tests → Legacy Dialogs 
→ K Realted Samples

Gambar 3.30 Tampilan analyze data pada SPSS.

5. 	 Masukkan kelompok Obat A, Obat B dan Obat C ke Test 
Variables. Kemudian pilih Cochran’s Q

Gambar 3.31 Tampilan related samples pada SPSS.
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	 Uji komparasi yang paling tepat untuk digunakan pada 
kasus di atas adalah:

	 a. 	 Cochran’s Q
	 b.	 Fisher’s Exact
	 c.	 Chi Square
	 d.	 Mc Nemar
	 e.	 Spearman

4. 	 Mahasiswa Kedokteran Universitas Surabaya melakukan 
penelitian observational dengan menggunakan data 
sekunder. Data yang digunakan merupakan data rekam 
medis yang diperoleh dari suatu rumah sakit. mahasiswa 
melihat perkembangan berat badan bayi yang kontrol 
oleh rumah sakit tersebut. Penelitian ini membandingkan 
berat badan awal dengan berat badan setelah dilakukan 
pemberian intervensi. Berat badan digolongkan dengan 
2 kategori yaitu “berat badan rendah” dan “berat badan 
normal”. Hasil yang diperoleh sebagai berikut.

dilakukan dengan membagi 2 kategori yaitu “Normal” 
dan “Tinggi”. Hasil yang diperoleh sebagai berikut.
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di pelayanan baik dan pelayanan buruk. Hasil penilaian 
yang diperoleh sebagai berikut.

	 Pernyataan yang paling sesuai dari kasus di atas adalah:

	 a. 	 Kedua data saling berpasangan
	 b. 	 Skala data non-parametrik
	 c. 	 Uji Shapiro-wilk menjadi uji prasyarat
	 d. 	 Data bersifat heterogen
	 e. 	 Butuh penambahan variabel

15. Seorang peneliti melakukan analisa data dengan 
menggunakan uji komparasi pada suatu data penelitian. 
peneliti tersebut memilih uji tersebut dikarenakan skala 
data penelitian adalah ordinal. Penelitian ini menggunakan 
sampel ibu rumah tangga di suatu desa terhadap 
pengetahuan terhadap pengolahan makan yang baik. 
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	 d.	hasil sebelum  masuk kuliah memiliki nilai rerata yang 
		  lebih besar
	 e.	 hasil  setelah  masuk  kuliah  memiliki  nilai  signifikansi 
		  yang lebih besar

19.	 seorang dosen ingin mengetahui pendapat mengajar 
sebelum dan sesudah mengikuti pelatihan. Hasil yang 
didapat adalah:

Uji Komparasi Non-Parametrik176

	 Lakukan analisis dengan menggunakan mc nemar dan 
bapakah terdapat perbedaan pendapat :

	 a.	 terdapat  perbedaan  mengajar  pendapat  sebelum  dan 
		  sesudah mengikuti pelatihan
	 b.	semua mahasiswa tidak menyukai cara mengajar dosen 
		  tersebut sebelum dan sesudah mengikuti pelatihan
	 c.	 semua mahasiswa  menyukai  cara  mengajar dosen ter- 
		  sebut
	 d.	tidak terdapat perbedaan  pendapat  mengajar  sebelum 
		  dan sesudah mengikuti pelatihan
	 e.	 cara  mengajar  dosen  tersebut  sama,  sekalipun  sudah 
		  mengikuti pelatihan

20.	 seorang peneliti ingin mengetahui kecenderungan jenis 
kelamin dalam partisipasi dalam mengikuti penelitian 
sebagai responden. dan didapat hasil sebagai berikut :
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JAWABAN DAN PEMBAHASAN

1. 	 B
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi penilaian menjadi 
2 kategori yaitu “memuaskan” dan “tidak memuaskan”. 
Pada penelitian juga menunjukkan terdapat satu kelompok 
saja yaitu penilaian standar pelayanan. Sehingga dapat 
disimpulkan uji yang digunkan adalah Chi Square Satu 
Sampel.

2. 	 E
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi penilaian menjadi 
2 kategori yaitu “pengetahuan baik” dan “pengetahuan 
buruk”. Pada penelitian juga menunjukkan terdapat dua 
kelompok yaitu “Puskesmas” dan “Rumah Sakit”. Oleh 
karena itu dapat disimpulkan uji yang digunakan adalah 
Fisher’s Exact Test.

3. 	 A
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi kadar C-Reactive 
Protein menjadi 2 kategori yaitu “normal” dan “tinggi”. 
Pada penelitian juga menunjukkan terdapat 3 kelompok 
(kelompok lebih dari 2) yaitu “dosis 10 mg”, “dosis 20 
mg” dan “dosis 30 mg”, sehingga dapat disimpulkan uji 
yang digunkan adalah Cochran’s Q.

4. 	 C
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi penilaian berat 
badan menjadi 2 kategori yaitu “berat badan rendah” dan 
“berat badan normal”. Pada penelitian juga menunjukkan 
keterkaitan antar kelompok yaitu perubahan berat badan 

Uji Komparasi Non-Parametrik194
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bayi, sehingga dapat disimpulkan uji yang digunkan 
adalah Mc Nemar.

5. 	 D
	 Penelitian yang dilakukan mahasiswa dengan uji Fisher’s 

Exact yang memiliki persyaratan yaitu skala data 
nominal atau ordinal, merupakan tabel 2x2 yang berarti 
jumlah kelompok hanya berjumlah 2, uji normalitas dan 
homogenitas tidak dibutuhkan dalam persyaratan uji 
tersebut. Fisher’s Exact digunakan pada sampel bebas 
(independent).

6.	 A
	 Penelitian yang dilakukan oleh peneliti merupakan peneli

tian dengan skala data ordinal. Peneliti juga membagi 2 
kelompok yang saling tergantung yaitu sebelum dan se
sudah penyuluhan (kelompok berpasangan). Selain itu 
penilaian kuesioner dilakukan kategorisasi yaitu penge
tahuan baik dan pengetahun buruk, sehingga dapat disim
pulkan uji komparasi yang paling sesuai adalah MC 
Nemar.

7.	 D
	 Penelitian tersebut memperlihatkan hasil uji Fisher’s 

Exact. Pada Tabel 1 memperlihatkan total responden 
adalah 20 orang yang terbagi pengetahuan baik sebesar 
13 orang dan pengetahuan buruk sebesar 7 orang. Pada 
Tabel 2 memperlihatkan “2 cells (50.0%) have expected 
count less than 5. The minimum expected count is 3.50” 
sehingga hasil uji yang digunakan adalah Fisher’s Exact 
Test dengan nilai sig. adalah 1,000 (p value>0,05). Oleh 
karena itu kesimpulannya dari hasil pengujian ini adalah 
tidak adanya perbedaan tingkat pengetahuan antara kedua 
desa (tidak signifikan).

195
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8.	 C
	 Penelitian tersebut memperlihatkan pembagian menjadi 3 

kategori yaitu obat standar, obat jenis A dan obat jenis B, 
sehingga lebih dari 3 kelompok penelitian. Pengukuran 
penelitian juga dilakukan dengan kategori yaitu normal 
dan hipertensi, sehingga skala data pada penelitian adalah 
non parametrik. Oleh karena itu, uji komparasi yang 
paling sesuai adalah uji Cochran’s Q.

9.	 B
	 Penelitian yang dilakukan dengan membagi 3 kategori 

yaitu “hipoglikemia”, “normal” dan “hiperglikemia”, 
sehingga skala data pada penelitian tersebut adalah 
non-parametrik. Pada penelitian diasumsikan tabel 3x2, 
sehingga uji komparasi yang paling sesuai adalah Chi 
Square lebih dari 2 sampel.

10.	 E
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi penilaian ibu 
hamil menjadi 2 kategori yaitu “baik” dan “buruk”. Pada 
penelitian juga menunjukkan terdapat satu kelompok saja 
yaitu penilaian standar pelayanan bidan desa, sehingga 
dapat disimpulkan uji yang digunkan adalah Chi Square 
Satu Sampel.

11.	 E
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi penilaian pre dan 
post-test menjadi 2 kategori yaitu “Lulus” dan “Tidak 
Lulus”. Pada penelitian juga menunjukkan keterkaitan 
antar kelompok yaitu sebelum dan sesudah perkuliahan, 
sehingga dapat disimpulkan uji yang digunkan adalah Mc 
Nemar.
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12.	 D
	 Interpretasi pada kasus tersebut adalah 
	 l	Pada  penelitian  tersebut  memperlihatkan  skala  data 
		  adalah non-parametrik (Interval). 
	 l	Pada uji komparasi non-parametrik tidak membutuhkan 
		  uji normalitas dan homogenitas. 
	 l	Uji komparasi masih dapat dilakukan dengan menggu- 
		  nakan  uji komparasi  non-parametrik  dalam  kasus  ini 
		  adalah uji Mc Nemar.
	 l	Uji Reliabilitas tidak dibutuhan dan tidak terdapat pada 
		  kasus tersebut.

13.	 A
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non-parametrik, dikarenakan membagi penilaian menjadi 
2 kategori yaitu “pelayanan baik” dan “pelayanan buruk”. 
Pada penelitian juga menunjukkan terdapat dua kelompok 
yaitu “Poli Rawat Jalan” dan “Poli Rawat Inap”, sehingga 
dapat disimpulkan uji yang digunkan adalah Fisher’s 
Exact Test.

14.	 B
	 Interpretasi pada kasus tersebut adalah 
	 l	Kedua data pada kasus tersedut tidak berpasangan (Poli 
		  Rawat Jalan dan Poli Rawat Inap).
	 l	Pada  penelitian  tersebut  memperlihatkan  skala  data 
		  adalah non-parametrik (Interval). 
	 l	Pada uji komparasi non-parametrik tidak membutuhkan 
		  uji normalitas (Uji Shapiro Wilk). 
	 l	Uji homogenitas tidak dibutuhkan.
	 l	Penambahan variabel dapat mengubah tujuan dan meto- 
		  de penelitian secara keseluruhan.
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15.	 B
	 Penelitian yang dilakukan oleh peneliti merupakan 

penelitian dengan skala data ordinal. Peneliti juga membagi 
2 kelompok yang saling tergantung yaitu sebelum dan 
sesudah penyuluhan (kelompok berpasangan). Selain 
itu penilaian kuesioner dilakukan kategorisasi yaitu 
pengetahuan baik dan pengetahun buruk, sehingga dapat 
disimpulkan uji komparasi yang paling sesuai adalah MC 
Nemar.

16. 	 A
	 Jenis data dari hasil penelitian tersebut berupa data yang 

didapatkan dengan cara klasifikasi atau kategorisasi, 
sehingga disebut data Ordinal. Penelitian ini hanya 
memiliki satu kelompok sampel saja, sehingga uji yang 
cocok digunakan adalah uji chi square 1 sample.

17.	 B

	 Pada hasil analisis menggunakan crosstab dibagian bawah 
terdapat keterangan “2 cells (50,0%) have expected 
count less than 5. The minimum expected count is 2,07” 
sehingga hasil uji yang digunakan  adalah Fisher’s Exact 
Test dengan nilai sig. 0,68
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18.	 A
	 Hasil uji mc nemar:

	 Dari tabel hasil uji diketahui nilai sig adalah 0,405. (p 
value > 0,05) sehingga dapat diambil kesimpulan tidak 
ada perbedaan kebiasaan makan fast food sebelum dan 
sesudah masuk kuliah.

19.	 D
	 Hasil uji mc nemar:

	 Dari tabel hasil uji diketahui nilai sig adalah 0,219. (p 
value > 0,05) sehingga dapat diambil kesimpulan tidak 
terdapat perbedaan pendapat mengajar sebelum dan 
sesudah mengikuti pelatihan.
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20.	 B
	 Peneliti ingin mengetahui kecenderungan jenis kelamin 

dalam partisipasi dalam mengikuti penelitian sebagai 
responden. Dalam hal ini hipotesis yang tepat adalah 
menggambarkan kaitan antara jenis kelamin dengan 
partisipasi dalam mengikuti penelitian, sehingga hipotesis 
yang tepat adalah : 

	 H0 : tidak ada perbedaan signifikan terkait jenis kelamin 
pada peserta penelitian

	 H1 :  ada perbedaan signifikan terkait jenis kelamin pada 
peserta penelitian

21.	 A

	 Dari tabel diatas dapat diketahui :
	 -	 Nilai chi square hitung adalah 85,675
	-	  Nilai Asymptotic Significance 2-sided adalah 0,000 
	-	  Nilai p (o,ooo) < ꭤ (0,05 atau 5 %) 
	 -	 Total data yang dianalisis adalah 750
	 -	 Terdapat  keterangan  “0  cells  (0,0%)  have  expected 
		  count less than 5. The minimum expected count is 14,98” 
		  yang  artinya asusmsi  penggunaan  Chi  square  dalam 
		  penelitian  ini  sudah  tepat,  sebab  tidak  ada  sel  yang 
		  memilihi  frekuensi  harapan  dibawah  5  dan frekuensi 
		  harapan terendah adalah 14,98.

Uji Komparasi Non-Parametrik200



Komparasi Parametrik 
dan Non-Parametrik

22.	 E
	 Syarat pengujian Chi square > 2 sample:
	 -	 Untuk mengetahui apakah terdapat perbedaan antar ke- 
		  lompok
	 -	 Data yang digunakan bersifat kategori atau nominal
	 -	 Analisis  dilakukan  pada  lebih  dari  2  kelompok yang 
		  tidak berpasangan atau independent.
	 -	 Untuk menghasilkan hasil yang valid, sebaiknya meng- 
		  gunakan sampel yang cukup besar (> 20)
	 -	 Tidak  boleh  ada  nilai  harapan  yang bernilai kurang	

	 dari 5

	 Dari uraian diatas maka dapat diambil kesimpulan analisis 
yang cocok adalah Chi square > 2 sample.

23.	 D

	 Hasil uji Cochran’s Q diatas menunjukkan nilai sig 0,846 
(p value > 0,05). Sehingga dapat disimpulkan tidak ada 
perbedaan antara kinerja mesin X, mesin Y dan mesin Z 
atau mesin X, mesin Y dan mesin Z mempunyai kinerja 
yang sama.

201



Komparasi Parametrik 
dan Non-Parametrik

24.	 C

	 Hasil uji Cochran’s Q diatas menunjukkan nilai sig 0,115 
(p value > 0,05). Sehingga dapat disimpulkan tidak ada 
perbedaan frekuensi karyawan yang selesai pada ketiga 
jenis stimulasi

25.	 A

	 Pada tabel crosstab diatas dapat diuraikan :
	 -	 Responden sebelum olah raga memiliki nadi tidak nor- 
		  mal dan  sesudah  olahraga  memiliki  nadi tidak normal 
		  adalah 13
	 -	 Responden  sebelum  olah  raga  memiliki  nadi  normal 
		  dan  sesudah  olahraga memiliki nadi tidak normal ada- 
		  lah 5
	 -	 Responden sebelum olah raga memiliki nadi tidak nor- 
		  mal dan sesudah olahraga memiliki nadi normal adalah 
		  2
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	 -	 Responden sebelum olah raga memiliki normal dan se- 
		  sudah olahraga memiliki nadi tnormal adalah 2
	 -	 Total responden/sample adalah 22
	 -	 Total responden/sample yang sebelum olahraga memi- 
		  liki nadi tidak normal adalah 15
	 -	 Total responden/sample yang sebelum olahraga memi- 
		  liki nadi normal adalah 7
	 -	 Total responden/sample yang sesusah olahraga memili- 
		  ki nadi tidak normal adalah 18
	 -	 Total responden/sample yang sesusah olahraga memili- 
		  ki nadi normal adalah 4

	 Dari uraian diatas  maka jawaban yang benar adalah: Res
ponden sebelum olah raga dan sesudah olahraga memiliki 
nadi tidak normal adalah 13.

26.	 A.
	 Tabel data yang disajikan adalah bentuk 2x2 dan syarat 

melakukan uji chi square adalah Apabila bentuk tabel 2 x 
2, maka tidak boleh ada satu cell yang memiliki frekuensi  
harapan atau expected  count (“Fh”) kurang dari 5 (lima). 
Apabila ada maka akan diganti dengan “Fisher Exact Test

27.	 D.
	 Langkah yang tepat dalam melakukan uji chi square satu 

sample dengan SPSS adalah:  Masukkan data → analyze 
→ Non Parametric Test → Legacy Dialogs → Chi Square 
→Pindahkan data ke kolom Test Variable List → OK

28.	 B.
	 Syarat melakukan uji chi square adalah  :
	 -	 Tidak  ada  cell   yang   memiliki   nilai   frekuensi  atau 
		  “Actual Count (F0)” sebesar 0 (Nol). 
	 -	 Apabila  bentuk tabel 2 x 2, maka  tidak boleh ada satu 
		  cell yang memiliki  frekuensi  harapan  atau  expected	
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	 count (“Fh”)  kurang dari  5 (lima).  Apabila ada maka 
		  akan diganti dengan “Fisher Exact Test”
	 -	 Apabila bentuk tabel lebih dari 2 x 2, misal 2 x 3, maka 
		  jumlah  cell  dengan  frekuensi  harapan  tau  expected 
		  count  (“Fh”)  yang  kurang  dari  5  (lima)  tidak boleh 
		  lebih dari 20%
	 Dari pernyataan soal mengarah pada uji chi square dan 

karena hanya memiliki 1 kelompok sampel maka uji yang 
cocok adalah Chi Square Satu Sampel.

29.	 E.
	 nilai N adalah adalah jumlah total subjek / responden 

dalam penelitian 107 dan Sig. 0,304 > p value ( 0,304 
> 0,05) sehingga dapat diambil kesimpulan tidak ada 
perbedaan sebelum dan sesudah pemberian obat herbal

30.	 B
	 Sig. 0,03 > p value (0,03 > 0,05) sehingga dapat diambil 

kesimpulan ada perbedaan sebelum dan sesudah 
penyuluhan kesehatan , H0  ditolak ada perbedaan skor 
pengetahuan sebelum dan sesudah penyuluhan kesehatan 
atau H1  diterima ada perbedaan skor pengetahuan 
sebelum dan sesudah penyuluhan kesehatan.

31.	 C 
	 Uji mc nemar merupakan uji statistik non parametrik dan 

tidak bisa digunakan untuk skala data interval dan rasio

32.	 D.
	 Syarat untuk melakukan uji chi square adalah tidak boleh 

ada sel yang memiliki nilai frekuensi harapan < 5. Nilai 
frekuensi harapan terendah adalah 27,61 yang artinya 
nilai tersebut > 5, sehingga asumsi penggunaan chi square 
dalam penelitian ini sudah memenuhi syarat.
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33.	 D
	 Dari tabel hasil uji Cochran pernyataan yang tepat adalah:
	 Jumlah sampel 12
	 Nilai tes Cochran 14,163
	 Nilai df 3
	 Nilai sig 0,003. 
	 ꭤ =  5 % (0,05) maka nilai sig < ꭤ (0,003 < 0,05)

34.	 E
	 Langkah pengujian Cochran yang BENAR adalah 

Analyze → Non Parametric Tests → Legacy Dialogs → 
K Realted Samples → pindahkan data ke test variabel → 
centang cocran’s Q → OK

35.	 A. 
	 Jika hasil uji cochran memiliki nilai sig < ꭤ, maka dapat 

dikatakan ada perbedaan dalam pengamatan sebelum, 
ketika menjalani pengobatan dan sesudah menjalani 
pengobatan. Dari hasil penelitian pada soal diketahui nilai 
sig 0,068 > ꭤ (0,05) sehingga dapat diambil kesimpulan 
tidak terdapat perubahan pilihan cara pengobatan terhadap 
pengobatan herbal

36.	 B
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non parametrik, dikarenakan membagi penilaian menjadi 
2 kategori yaitu “Memuaskan” dan “Tidak Memuaskan”. 
Pada penelitian juga menunjukkan terdapat satu kelompok 
saja yaitu penilaian standar pelayanan tenaga kesehatan 
di polo rawat jalan. Sehingga dapat disimpulkan uji yang 
digunkan adalah Chi Square Satu Sampel.

37.	 A
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non parametrik, dikarenakan membagi penilaian penge
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tahuan ibu dengan balita stunting menjadi 2 kategori yaitu 
“Pengetahuan Baik” dan “Pengetahuan Buruk”. Pada 
penelitian juga menunjukkan keterkaitan antar kelompok 
yaitu perubahan pengetahuan ibu dengan balita stunting. 
Sehingga dapat disimpulkan uji yang digunkan adalah 
Mc Nemar.

38.	 D
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non parametrik, dikarenakan membagi kadar Kolesterol 
menjadi 2 kategori yaitu “normal” dan “tinggi”. Pada 
penelitian juga menunjukkan terdapat 3 kelompok 
(kelompok lebih dari 2) yaitu “dosis 0,5 mg”, “dosis 1 
mg” dan “dosis 1,5 mg”. Sehingga dapat disimpulkan uji 
yang digunkan adalah Cochran’s Q.

39.	 C
	 Pada penelitian tersebut memperlihatkan skala data 

adalah non parametrik, dikarenakan membagi penilaian 
menjadi 2 kategori yaitu “pelayanan baik” dan “pelayanan 
buruk”. Pada penelitian juga menunjukkan terdapat dua 
kelompok yaitu “Puskesmas” dan “Posyandu”. Sehingga 
dapat disimpulkan uji yang digunkan adalah Fisher’s 
Exact Test.

40.	 E
	 Pada penelitian tersebut memperlihatkan skala data adalah 

non parametrik, dikarenakan membagi penilaian menjadi 
2 kategori yaitu “memuaskan” dan “tidak memuaskan”. 
Pada penelitian juga menunjukkan terdapat satu kelompok 
saja yaitu penilaian standar pelayanan poli rawat jalan. 
Sehingga dapat disimpulkan uji yang digunkan adalah 
Chi Square Satu Sampel.
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